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1 Introduction
The Danish Coastal Authority (DCA) is preparing for the second cycle of the implementation
of the EU Floods Directive. While implementing the EU Floods Directive in Denmark, the DCA
is required to appoint areas where coastal and fluvial flood risk level is significantly high, to
provide more detailed mapping at these specific areas, and to guide towards the identification
of risk management measures.
DCA aims at adapting the screening assessment, developed during the first cycle, towards a
more risk based approach. This requires changes in the screening process to include new
knowledge on the physical definition of risk areas, climate scenarios, and the inclusion of both
tangible and in-tangible exposure classes.
DCA has approached Deltares to support in the transition to a more risk based approach. To
target the work on specific issues, two sub-groups have been created having participants
from both Deltares and the DCA. The topics of the two sub-groups have been defined as
follows: (1) Climate change scenarios, (2) Identification of the exposure and the risk criteria in
defined areas. The present report focusses on the second topic, the identification of the
exposure and the risk criteria in defined areas.
To ensure a better basis for the selection of areas of significant flood risk, the DCA has more
specifically requested Deltares to develop a risk index-based method delineating the risk level
on the basis of the available hazard and exposure datasets. To that end, exposure types (i.e.
receptors) to be included in the risk assessment have to be defined. In addition, the
quantification of the vulnerability in an exposure indicator should be developed on the basis of
the available datasets. Moreover, risk integration methodologies for multiple return periods
should be then proposed, for the purpose of defining the areas of significant flood risk. Finally,
the defined methodology should be supported by a Risk Screening Toolbox to be developed
in ArcGIS for the purpose of screening along the Danish coast.
The report is set up as follows. An introduction is given in Chapter 1 Chapter 2 presents the
objectives of the project. Chapter 3 describes the method developed for the screening
process. Chapter 4presents the methodology for the appointment of management areas. The
application is demonstrated in Chapter 5 on selected exposure classes. The report is then
concluded in Chapter 6 and recommendations are provided in Appendix C.
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2 Objectives and process
This report aims at providing:







Identification of vulnerability types (i.e. receptors) to be included in the risk
assessment while screening the Danish coast;
Quantification of the vulnerability in an exposure indicator, for a pilot area and on the
basis of the available datasets;
Development of a risk index-based method, delineating the risk level on the basis of
the available hazard and exposure datasets;
Identification of methodologies for the risk integration for multiple return periods, for
the purpose of defining management areas with high-risk of coastal and fluvial
flooding and where the risk assessment/mapping will take place;
Description of a Risk Screening Toolbox developed in ArcGIS for the purpose of risk
level computation along the Danish coast.

During a joint DCA-Deltares workshop in Delft on February 14-16, 2017, the risk screening
assessment based on the Coastal Risk Assessment Framework (CRAF, see Chapter 3 for
more details) was presented to DCA.
The CRAF-based approach relies on the identification of so-called “hotspot” areas of
increased risk relative to the surrounding coast due to high hazard levels (e.g., flood depth)
and exposure of high-value receptors (e.g., population, critical infrastructure, etc.) using
qualitative indicator values (Chapter 3).
Although the CRAF methodology allows the identification of hotspot areas for multiple
individual return periods (probability of occurrence) of coastal hazards, the methodology was
not envisaged to compute an index of risk that is integrated across multiple return periods
(i.e., accounting for variations in impact for varying return period values). Based on the
received feedback from the workshop, a methodology for the combination of the risk index for
several return periods was developed (Chapter 4).
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3 Risk index-based method development
As part of the FP7 EU project RISC-KIT (see www.risc-kit.eu), a toolkit has been developed
providing a set of innovative methods, tools and management approaches to assess and
reduce coastal flood risk and to increase coastal resilience to hydro-meteorological events of
low-frequency but high-impact (van Dongeren et al., 2016).
The Coastal Risk Assessment Framework (CRAF) is the first element of the risk assessment
suite. Applied at a regional scale, CRAF permits a comprehensive and systematic approach
to undertaking risk assessment at a variety of levels of detail. One role is the identification
and selection of hotspots to be further analysed. Hotspots (potential Areas of Significant
Flood Risk) are defined in the project as specific locations along the coast where highresolution modelling and risk assessment are required to assess the coastal flood risk and to
develop and compare flood risk reduction measures. As such, hotspots, or groups of
hotspots, should be indicative of those areas where risk is highest.
3.1

Concept
The CRAF methodology provides two levels of analysis (two phases) at regional scale.
Phase 1 aims at screening the coastline in order to narrow down the risk analysis to a
reduced number of sectors which are subsequently geographically grouped into potential
hotspots (Figure 3.1). For an entire regional coast, it would be difficult to complete an in-depth
risk assessment. Phase 1 therefore facilitates the identification of exposure at flood risk
through the calculation of a risk index. The approach calculates Hazard and Exposure Indices
following an existing and established methodology (the index-based method).

Figure 3.1 Coastal Risk Assessment Framework (CRAF) for the assessment of coastal risks and for the evaluation
of adaptation measures, developed in the FP-7 European project RISC-KIT by a consortium led by Deltares.
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In Phase 1, the CRAF methodology combines several indicators into a single (risk) index,
thereby allowing a rapid comparison of coastal segments. Different types of hazard are
considered separately, whereas different exposures are combined for each type of hazard.
Still, the type of indicators considered in the index, the way they are ranked and the formula
used to combine these variables may differ between studies.
In general, the methodology described hereafter can be applied for other types of hazard in a
comparable manner. The results for different types of hazard can be combined in the last step
in an additive manner.
3.2

Hazard index
Hazards can be simply classified as flooding- and erosion-related ones. In addition, stormsinduced hazards taking place in the coastal zone although of terrestrial origin (i.e. fluvial /
flash floods) can also induce significant damages. The hazards to be considered in this
framework are: overwash, barrier breaching, coastal flooding, erosion, and fluvial floods.
Coastal flooding groups all the hazards related to temporary inundation of the coastal zone
due to storm-induced variations of mean water level (i.e. overwash, overtopping, and
inundation). The worst condition will be given by an inundation extent of all the areas
connected to the sea with an elevation lower than the screening water level, i.e. the so-called
bath tub approach. This approach is more or less appropriate for coastal sections where
elevation monotonically (more or less) increases landwards, and has been applied in
Denmark to compute the flood hazard extent.
For the purpose of developing a risk index-based method, only coastal inundation is
considered in this study as a potential coastal risk. Note however that other hazards may
influence the risk level along the coast of Denmark. Those include coastal erosion, fluvial
flooding, etc …
A hazard indicator will be ranked from 0 to 5 (None, Very Low, Low, Medium, High and Very
High). A null value is used in the absence of hazard. The ranking of the indicator value from 1
to 5 will depend upon the hazard intensities.
A simple process might be to define the maximum value of the hazard intensity for the whole
coast and to categorize in equal intervals (this should be done for the worst case scenarios to
obtain the highest possible intensity value – the same intervals should then be used for other
scenarios allowing a comparison between them). Thus, if the flood depth is considered as a
main characteristic and the maximum potential value is 4 metres in depth, the following
ranking could be used for instance:
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No flood: None (0);
Flood depth less than 1m: Very Low (1);
Flood depth 1 to 2m: Low (2);
Flood depth 2 to 3m: Medium (3);
Flood depth 3 to 4m: High (4);
Flood depth greater than 4m: Very High (5).
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However, such a simple ranking approach could be improved by using natural breaks
classification which considers the distribution of the intensities or could be approached from
an impact perspective by establishing user defined intervals (for example, any depth above
3m is Very High and below 0.3m is Low).
3.3

Exposure index
The exposure index aims at answering the question what is at stake within the potential
hazard areas. With this framework, impacts encompass loss of assets and lands value,
impacts on population, ecosystems and cultural heritage, impacts on key infrastructures
(transport, utilities, emergency services), and impact on the economy.
More precisely, the exposure index (iexp) measures the relative exposure for different receptor
types. Following the CRAF methodology, tailored for the Danish case, it is suggested to
consider the main types with the following sub-groups:




Direct impact
o Land Use
o Population density
o Ecosystems
o Cultural heritage
Systemic impact
o Transport systems
o Utilities
o Emergency services
o Economic activities

For example, the Land Use Exposure Indicator compares the relative value of exposed
assets and land along the coast. The type and the surface of land use can be derived from
CORINE Land Cover or from cadastral maps and their valuation from market valuation (Merz
et al., 2010) or end-user preference valuation.
The Population density is used to characterize the social vulnerability with respect to the
people living in flood prone areas. The indicator adds an additional dimension to land use
indicator, to allow differentiating between for example different urban areas.
Alternatively, an indicator relative to population could be also included, based on the social
vulnerability indicator approach (Cutter et al., 2013). The indicator considers differences
between populations along the coast based on their socio-economic characteristics and can
be derived from census data.
Ecosystems and cultural heritage can have a significant importance for tourism and therefore
the economy of a region. Also, both classes are of invaluable (intangible) worth for the wellbeing of the citizens.
The indirect impacts on transport, utilities and economic activities aim at better considering
the exposure of assets leading to systemic impacts. What is at stake here is not only the
exposed assets but how a loss of these assets may lead to higher order of losses (i.e.
respectively traffic disruption, loss of services such as provision of water or electricity, loss or
perturbation in a supply chain).
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The approach aims therefore at considering the exposed assets, in relation to the transport
systems, the utilities, the emergency services and the economic activities, and their
importance at different geographic scale. Approaching key stakeholders, producing a
schematic of the considered network and the locations of its key assets, and valuing their
importance are the recommended approach. If not possible, expert judgment could be used.
3.4

Exposure Indicators
The overall exposure indicator is calculated as the maximum index of all exposure classes,
with each indicator valued and ranked from 1 to 5. A computation of a maximum index is
proposed because:
1) due to the high resolution of the raster dataset it is unlikely that several categories fall
into one grid cell,
2) the purpose of the screening is to identify areas where an agglomeration of a number
of high/very high risk pixels takes place.
In case of using a geometric mean of all exposure classes to compute the overall exposure
index, high values of the indicator would be obtained exclusively by the combination of high
and very high exposure indicators. High to medium values would be obtained exclusively by
the combination of medium to very high indicators. Below such values, the identification and
differentiation between exposed areas would be unease by the range of combinations making
the results possible. Consequently, given the number of exposure indicators, a geometric
mean calculation would always result in an overall exposure indicator ranging from low to
medium, which would not reflect the importance of a certain area towards a certain exposure
category.
In the following the different indicators are described.

3.4.1

Direct impact – land use
The Land Use Exposure Indicator (iexp-LU) measures the relative exposure of land use.
For the application in the assignment we propose to use the CORINE land cover dataset. The
Land Cover project of the CORINE programme intended to provide consistent localized
geographical information on the land cover of Member States of the European Community. A
nomenclature for various scales has been developed to enable the decision-makers to
identify, analyse and monitor land use in the areas under their responsibility.
The CORINE land cover nomenclature is organized on three levels, the second one (15
items) being for use on scales of 1:500.000 and 1:1.000.000, is considered to be relevant for
the purpose of screening the Danish coastline.
The CORINE land cover nomenclature Level 2 is summarized in Table 3.1, together with a
representative value for each land use class, defined based on the relative importance (from
0 to 5). Note that this valuation is proposed only for the purpose of developing a risk indexbased method; this valuation should be refined after analysis of generated risk-index maps at
pilot locations.
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Table 3.1

CORINE land cover nomenclature level 2 and proposed valuation

CORINE land cover nomenclature
1.1. Urban fabric
1.2. Industrial, commercial and transport units
1.3. Mine, dump and construction sites
1.4. Artificial non-agricultural vegetated areas
2.1. Arable land
2.2. Permanent crops
2.3. Pastures
2.4. Heterogeneous agricultural areas
3.1. Forests
3.2. Shrub and/or herbaceous vegetation association
3.3. Open spaces with little or no vegetation
4.1. Inland wetlands
4.2. Coastal wetlands
3.4.2

Proposed valuation
5
4
3
2
2
2
2
2
1
1
1
1
1

Direct impact – population density
Population in flood prone areas is one of the most important aspects to be taken into account
in the screening process.
We propose to use population density, either based on census data, such as the European
INSPIRE datasets on population and demography, or national census data. The exposure
indicator is then based on the registered number of inhabitants per spatial unit (raster cell).
The consideration of population density allows for a more differentiated screening, taking
variations of population density within a single land-use class into account.

3.4.3

Direct impact – ecosystems
Ecosystems form valuable but vulnerable places in coastal areas. Particularly fresh-water
driven systems can be impacted by coastal flooding and associated saltwater intrusion.
However, saltwater ecosystems can be damaged due to wave impacts, high flow velocities
and increased water levels too.
In order to take into account the most relevant (coastal) ecosystems, it is proposed to assess
for areas under the Habitat Directive (Council Directive 92/43/EEC on the Conservation of
natural habitats and of wild fauna and flora), Birds Directive (Council Directive 2009/147/EC
on the conservation of wild birds) and UNESCO nature heritage sites.
Another aspect is the contamination of ecosystems with harmful substances from IPPC
installations, i.e. installations which fall under the Directive 2008/1/EC on “Integrated Pollution
Prevention and Control”. It is proposed to consider IPPC installations as a separate exposure
class in the screening.

3.4.4

Direct impact – cultural heritage
Cultural assets are of outmost societal and economic value. On the one hand cultural sites
enable an identification of the society with respect to their roots and history, while on the other
hand these cultural sites enable tourism and generate revenue.
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Damages to cultural assets can be assessed by taking their cultural significance into account
(Dassanayake et al. 2012). The significance is rated from very high (e.g. World Heritage
Sites) to low (Assets of local importance, Assets compromised by poor preservation).
Table 3.2

Cultural Assets Exposure Indicator Values (Dassanayake et al, 2012)

Value
1
2

Rank
Negligible
Low

3

Medium

4

High

Description
•
Assets with very little or no surviving archaeological interest.
•
Designated and undesignated assets of local importance.
•
Assets compromised by poor preservation and/or poor survival of
contextual associations.
•
Assets of limited value, but with potential to contribute to local
research objectives.
•
Designated or undesignated assets that contribute to regional
research objectives.
•
Scheduled Monuments (including proposed).
•
Undesignated assets of schedulable quality and importance.
•

5

3.4.5

Very High

•
•
•

Assets that can contribute significantly to acknowledged national
research objectives.
World Heritage Sites (including nominated sites).
Assets of acknowledged international importance.
Assets that can contribute significantly to acknowledged
international research objectives

Systemic impact – transport networks
One of the land use classes of the CORINE land cover classification refers to road and rail
networks. However, the class is often a non-dominant one and the transport system does not
appear in the LU exposure assessment. To analyse the transport system it is recommended
to follow the 5-level approach, as it proposed in the RISC-KIT Library of Coastal Vulnerability
Indicators Guidance Document (RISC-KIT, 2015).
For this phase, collecting information for each transport network about the location and
relative importance (capacity and use) of their assets (links and nodes) is essential for
mapping and valuing the system. The Transport System Exposure Indicator (iexp-TS) can then
be derived for each network (see Section 3.6) following the rules given in Table 3.3.
Table 3.3

Transport System Exposure Indicator Values

Value
1
2
3
4

Rank
None or Very Low
Low
Moderate
High

5

Very High
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Description
No significant transport network
Mainly local and small transport network
Transport network with local or regional importance
High density and multiple networks (train, road, airport) of local
importance or regional importance
High density and multiple networks (train, road, airport) of
national or international importance
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3.4.6

Systemic impact – utilities
For utilities providing essential services (e.g. water, electricity, telecom) a Utilities Exposure
Indicator should be derived for each sector following the same approach as described for the
transport system and the rules in Table 3.4.
Table 3.4

3.4.7

Utilities Exposure Indicator Values

Value
1
2
3
4

Rank
None or Very Low
Low
Moderate
High

5

Very High

Description
No significant utilities network
Mainly local and small utilities network
Utilities networks with local or regional importance
High density and multiple networks of local importance or
regional importance
High density and multiple networks of national or international
importance

Systemic impact – emergency services
An Emergency Services Exposure Indicator is proposed that should be derived for each
sector following the same approach as described for the transport system and utilities, and
following the rules given in Table 3.5.
Table 3.5

3.4.8

Emergency Services Exposure Indicator Values

Value
1
2
3
4

Rank
None or Very Low
Low
Moderate
High

5

Very High

Description
No significant element
Mainly local importance
elements with local or regional importance
High density and multiple elements of local importance or
regional importance
High density and multiple elements of national or international
importance

Systemic Impact – economic activities
For Economic Activities, an indicator should be ideally derived for each sector following a 6step approach, as proposed in the RISC-KIT Library of Coastal Vulnerability Indicators
Guidance Document (RISC-KIT, 2015). For this phase, collecting information and mapping
the location of assets and their relative importance (input, output, number of businesses) is
essential for the different business settings. The Economic Activities Exposure Indicator (iexpEA) can then be derived for each sector following for example the classification in Table 3.6.
Table 3.6

Value
1
2
3
4
5

Economic Activities Exposure Indicator Values

Rank
None or Very Low
Low
Moderate
High
Very High

Description
No significant economic activities
Mainly local small economic activities
Local or regional importance economic activities
Regional importance
National or international importance

EU Floods Directive in Denmark - Risk index-based method application
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The above mentioned approach is however depending on the availability of economic
information. Therefore, in the screening process only the number of workplaces is used as an
indicator for economic activities.
For this purpose, DCA provided a database with company information, specifying the number
of workplaces per company on their registered address. This information was geo-referenced
using another database with all addresses in Denmark and their XY-coordinates. The georeferencing approach is described in more detail in Appendix D.
3.5

Risk index
The Risk Index is calculated using the square root of the geometric mean of the hazard
indicator (ih) and the overall exposure indicator (iexp). The different exposures are combined
for each type of hazard. It means the Risk Index is given for a specific hazard but considering
the overall exposure level.

3.6

Spatial modelling approach

𝑅𝐼 = �(𝐼ℎ ∗ 𝐼𝑒𝑥𝑝 )

In order to allow for the risk screening for the entire coastline of Denmark, an efficient and
robust spatial modelling approach is required.
It is proposed to apply a gridded (raster based) approach. The main advantage, compared to
a polygon based zoning approach, is a significant increase in computational performance and
a possible reduction of file sizes. Moreover, a gridded approach enables the consideration of
the spatial variation of both hazard and exposure, while the polygon based zoning approach
only considers average values per hazard zone/ band.
It is important to highlight that the aggregation into a regular raster also allows for accounting
existing uncertainties such as in flood footprints and exposure data. Using the static bath tub
approach (sea water on land tool) the resulting flood footprint can only be an approximation,
as waves, wind setup and other hydrodynamic effects cannot be considered in this approach.
Finally, the generalization into a grid promotes a focus on the methodology and outcomes.
There is a trade-off between resolution and computational speed. However, the calculation
times for raster datasets (geotiff) are not dominated by the resolution but by reading/writing
times of the data storage. Recommendations on the resolution will be given in Appendix C.
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4 Appointment of areas of significant flood risk
This section describes the approach for the appointment of management areas with high risk
level of flooding. The objectives are presented in Section 4.1. Sections 4.2 and 4.3 present a
schematic coastal section and example risk indexes computed using the CRAF-based
approach that will be used in the description and analysis of risk integration methodologies in
Section 4.4 and 4.5. A final summary and recommendations are given in Section 4.6.
4.1

Objective
The objective of this chapter is to present multiple qualitative risk integration methodologies,
to present their strengths and weaknesses, and to make recommendations to DCA about the
most appropriate methodologies for application in the Danish screening assessment.
The main challenge in the selection of appropriate methodologies is the use of coastal risk
indicators, which are a qualitative measure (e.g., very high, high, medium, low, very low) of
risk, rather than a quantitative measure (e.g., economic loss in DKK, loss of life, etc.) of risk.
Standard quantitative risk integration methods can therefore not be used to integrate the
results of the screening assessment for multiple return periods. This chapter will consequently
focus on integration methods in which a qualitative assumption is made with regard to the
return period (or probability of occurrence). The methodologies will be illustrated with an
example of a schematic coastal stretch.

4.2

Schematic Coastal Stretch
The results of varying risk integration methodologies are computed for a schematic coastal
stretch as shown in Figure 4.1. The schematic coastal stretch contains a coastal town with
high-ranking exposure and vulnerability indicators (e.g., high population density, land-use,
critical infrastructures, and cultural assets). A smaller village lies close to the shore, which
contains exposure and vulnerability indicators that are of higher value than the surrounding
area (green), but of lower value than in the coastal town (e.g., lower population density in the
village than the town, fewer critical infrastructures, etc.). The coastal stretch also contains a
branching motorway that is of national importance, and thus labelled with high exposure and
vulnerability indicators.
Figure 4.1 also shows the flood extent for three return periods, where increasing return
periods lead to both greater flood extent and to greater flood depth in inundated areas. The
coastal village is inundated to varying depths for return periods of 20 years and greater,
whereas the coastal town is (mostly) not inundated, except in the case of the 1000 year return
period. The extent to which the national motorway is inundated, and the depth of inundation,
increases for increasing return periods, with one branch of the motorway already being
flooded in the 20 year return period situation.
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Figure 4.1 Schematic coastal stretch with computational mesh indicated by thin black lines. Flood extent lines for
three return periods are indicated by dashed lines.

4.3

Synthetic risk indicators in the coastal stretch
Based on the flood extent shown in Figure 4.1 and the qualitative exposure indices described
in Section 4.2, Figure 4.2 shows synthetic risk indices for the coastal stretch for three return
periods. Following the CRAF-based approach, the qualitative risk indices are based on a
combination of hazard levels (e.g., flood depth) and exposure and vulnerability indicators,
where combinations of high hazard levels and high exposure and vulnerability indicators lead
to high risk index values. Combinations of low hazard levels and high exposure and
vulnerability indicators, or high hazard levels and low exposure and vulnerability indicators,
lead to medium risk index values, whereas combinations of low hazard levels and low
exposure and vulnerability indicators lead to low risk index values.
Figure 4.2 shows medium to high risk indices for the coastal village for all three return
periods, whereas the coastal town shows no risk index (i.e., no flooding) in the 20 year return
period situation, high risk indices in small sections of the town in the 100 year return period
situation, and large extents of very high risk indices in the 1000 year return period situation.
The risk indices related to the national motorway are higher than the surrounding area due to
its high exposure and vulnerability indicator value. Note that the results in Figure 4.2 are
intended purely for illustrative purposes, and that DCA is recommended to use the full CRAFbased hazard and exposure qualification approach discussed in the joint DCA-Deltares
workshop to compute risk indices in the screening of the Danish coast.
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Figure 4.2 Coastal Risk Index following the CRAF-based approach for three return periods: 20 years (top left
panel), 100 years (top right panel) and 1000 years (bottom left panel).

The following section will discuss and illustrate methodologies to integrate risk indices across
multiple return periods, viz. 20, 100 and 1000 years. Methodologies are grouped according to
whether they differentiate risk indices for varying return periods or not.
4.4

Methods that do not differentiate for return period
The following methods do not account for variations in the probability of occurrence between
20, 100 and 1000 year return periods. In a generalised description, these methods may be
described as assigning equal importance to all return periods. Depending on the specific
methodology, such approaches may accentuate high-impact, low probability hazard risk
areas, or simply high-probability hazard areas.

4.4.1

Method 1: Simple summation of risk indices
In this methodology, the computed risk indices for all cells are summed for the three return
periods. For this purpose quantitative values are assigned to the qualitative indices as
follows:
Very high (5), high (4), medium (3), low (2), very low (1). A qualitative ranking of very high to
medium risk areas is subsequently found according to ranges defined in Table 4.1
The results of the risk integration according to this method are shown in Figure 4.3. The
results show that Method 1 has a tendency to highlight medium to high value areas that are
flooded frequently (e.g., the coastal village and the north-eastern motorway branch). The
method only identifies part of the coastal town as an area of risk, and does not represent
changes in impact between the 100 year and 1000 year return period events well.
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Table 4.1

Index summation range and risk qualification

Index summation range
11–15 (equivalent to one “very high” and two “medium”, or higher)
9–11 (equivalent to one “high”, one “medium” and one “low”, or
higher)
7–9 (equivalent to one “high”, one “low” and one “very low”, or
higher)

Qualification
Very high risk
High risk
Medium risk

Figure 4.3 Risk integration according to Method 1 (simple summation).

4.4.2

Method 2: Marking hotspots
In this methodology, all cells that have a high or very high risk index for any return period is
defined as a “hotspot”. These areas therefore represent any area that may suffer high to very
high impacts due to a flood event, but does not attribute a probability of the occurrence of the
impact to the cell ranking and does not differentiate between levels of impact or risk.
The results of Method 2 are shown in Figure 4.4. The results show a larger spread in the
definition of areas at risk than Method 1 (Figure 4.3), but due to the contribution of the 1000
year return period event to the identification of hotspots, this method loses resolution to
distinguish between areas at risk and can in most cases be computed using the results of the
1000 year return period event only.
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Figure 4.4 Risk integration according to Method 2 (hotspot marking). Areas at risk are shown in red.

4.4.3

Method 3: Maximum risk indicators
In this methodology, the maximum risk index per cell for all return periods is used to identify
areas of risk. Only cells that have high or very high risk indices are included. The
methodology is very similar in this sense to Method 2, but maintains some discriminatory
power to distinguish between levels of impact and risk.
The results of Method 3 are shown in Figure 4.5. The results are very similar to those for
Method 2 (Figure 4.4), with added information for very high risk areas. Similarly to Method 2,
Method 3 generally highlights cells with medium to very high exposure and vulnerability
indicators that are flooded during the 1000 year return period event.
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Figure 4.5 Risk integration according to Method 3 (maximum risk).

4.5

Methods that differentiate for return period
The methods in Section 4.4 ignore the effect of the return period (or probability of occurrence)
of storm events. This result of this is that Method 1 tends to overstate the importance of the
frequency of flooding compared to the impact of flooding, whereas Methods 2 and 3 highlight
the worst-case flood event only. These limitations appear not to fit the requirements of DCA
for a risk analysis of the Danish coast, and therefore in this section four methods are
described that attempt to account for the probability of occurrence in a qualitative way.

4.5.1

Method 4: Weighted summation
In this methodology, the effect of the probability of occurrence is accounted for by first
assigning quantitative values to the qualitative risk indices (i.e., Very high - 5, high - 4,
medium - 3, low - 2, very low - 1) and subsequent multiplication of this quantitative score by a
factor representing the probability of occurrence. The use of the actual probability of
occurrence (1/20, 1/100, and 1/1000, respectively) would lead to significantly more
importance being placed on the 20 year return period event compared to the 100 and 1000
year return period events, because of the difference in range of the qualitative impact score
(individual risk index: 1–5) compared to the variation in the probability of occurrence. To avoid
this discrepancy in the range of factors, other weights are used to qualitatively describe the
return period, as for instance specified in Table 4.2. Due to the inherent impossibility of linking
quantitative return periods with qualitative risk indices however, the multiplication factors in
Table 4.2 are arbitrary by definition and therefore highly sensitive. Any selection of
multiplication factor is likely to be open to substantial criticism by stakeholders and the
scientific community. If this method is applied, despite the clear drawbacks, a qualitative
ranking of very high to medium risk areas can subsequently be found according to ranges
such as those defined in Table 4.3.
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The results of Method 4 are shown in Figure 4.6. The results qualitatively show similarity with
those of Method 1 (simple summation; Figure 4.3), but with greater highlighting of low-value
coastal areas that are flooded in the 20 year return period event. The methodology does not
identify a large section of the coastal town as an area of potential risk. It should be noted that
in order to highlight the coastal town as an area of potential risk, the factors in Table 5.2
would have to be inverted (i.e., larger values for larger return periods), which is contrary to
risk integration theory. The results therefore show that the use of multiplication factors to
represent the role of return periods will almost certainly not lead to the desired identification of
areas at risk.
Table 4.2

Return period and factor multiplication

Return period
20 years
100 years
1000 years
Table 4.3

Multiplication factor
3
2
1

Index summation range and risk qualification

Index summation range
20–25
15–20
10–15

Qualification
Very high risk
High risk
Medium risk

Figure 4.6 Risk integration according to Method 4 (weighted summation).

4.5.2

Method 5: Marking hotspots and return periods
Similarly to Method 2, this methodology is based on the identification of hotspots of risk,
defined as cells with high, or very high risk indices (although other, more flexible definitions
may be possible). Contrary to Method 2 however, this assessment is carried out for all return
periods, and the minimum return period for which a cell becomes a hotspot is recorded.
Hotspot cells can subsequently be labelled as very likely to occur (20 year return period),
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likely to occur (100 year return period), or potentially to occur (1000 year return period), see
Table 4.4. If the impact is assumed to vary little between cells that have been identified as
hotspots, then the likelihood of occurrence can be used to qualify and compare the level of
risk, where very likely hotspots lead to very high risk, and potential hotspots lead to medium
risk (Table 4.4).
The results of Method 5 are shown in Figure 4.7. The results qualitatively show similar results
to Methods 2 and 3, but with greater definition of the integrated risk associated with each cell.
The method identifies both the coastal village and the coastal town as potential areas of risk,
as well as large sections of the national motorway. Due to the way the risk qualification is
linked to the return periods at which hotspots occur, the methodology would require to be
adapted in case more return period analyses are included, so that each risk qualification
spans a range of return periods (e.g., very high risk corresponds to hotspots with 10–30 year
return period).
Table 4.4

Return period at which a cell becomes a hotspot and risk qualification

Return period of hotspot
20 year
100 year
1000 year

Qualification
Very likely hotspot / Very high risk
Likely hotspot / High risk
Potential hotspot / Medium risk

Figure 4.7 Risk integration according to Method 5 (marking hotspots and return periods).

4.5.3

Method 6: Hotspot thresholds defined by return period
Whereas Method 5 assumes hotspots to occur only in areas with high and very high risk
indices, this methodology allows a flexible approach to the definition of “hotspots”. In this
manner, areas may be considered “hotspots” if the impact of a storm is lower, but this occurs
more frequently (lower return period). In this methodology criteria such as those defined in
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Table 4.5 can be used to identify varying thresholds for the definition of hotspots according to
the return period under examination.
The integrated risk assessment following this methodology is shown in Figure 4.8. The left
panel of this figure shows for what return period areas are defined as hotspots (e.g., the
coastal village is defined as a hotspot in the 20 year return period situation because it has
medium to high risk indices). Since the return period of the flooding event is already used to
define the threshold for the definition of a hotspot (lower return periods have lower
thresholds), return periods cannot also be used to indicate areas at greater or lesser risk in
the final risk integration (right panel in Figure 4.8), as this would lead to double-counting of
the return period effect. Despite a difference in approach, this methodology provides a similar
analysis of areas at risk to those identified using Method 5 (Figure 4.7).
Table 4.5

Definition of hotspots for varying return periods

Return period
20 year
100 year
1000 year

Risk index range for qualification as a hotspot
Medium – very high risk
High – very high risk
Very high risk

Figure 4.8 Risk integration according to Method 6 (hotspot thresholds defined by return period). Intermediate
results showing return period at which hotspot is defined (left panel) and final identification of areas at risk
(red; right panel).

4.5.4

Method 7: Thresholds of risk approach
This methodology seeks to implicitly account for equivalence between more frequent, but
lower impact flood events, and less frequent, higher impact flood events. This approach was
proposed by DCA during the joint DCA-Deltares workshop in February 2017. In the example
provided below, this equivalence is implied for e.g., medium impact (medium risk index) in a
20 year return period event, and very high impact (very high risk index) in a 1000 year return
period event. Following this methodology, cells are defined to have a medium to very high
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integrated risk if they fulfil any of the criteria specified in Table 5.6. It should be noted that
modification of the criteria thresholds in this method is possible, particularly if the risk indices
are first quantified as in Methods 1 and 4, and advisable for specific tailoring to the needs of
the Danish screening.
The results of the integrated risk assessment following Method 7 are shown in Figure 4.9. It
can be seen that the areas of risk identified in this methodology are similar to those found
using Methods 5 and 6, but that compared to Method 5, the integrated risk is qualified lower.
Following the criteria given in Table 5.6, no areas of very high risk are defined in the
schematic coastal stretch. Since very high impact (very high risk indices) are unlikely to occur
in the 20 year return period analysis of the Danish coast (since receptors in these areas
would likely be adapted, or removed), lower threshold values than those in Table 5.6 may be
required to effectively categorise integrated risk levels.
Table 4.6

Integrated risk qualification for varying risk indices and return periods

Risk index
Very high (20 year return period)
High (20 year return period), or Very high (100 year
return period)
Medium (20 year return period), or High (100 year
return period), or Very high (1000 year return period)

Integrated risk qualification
Very high risk
High risk
Medium risk

Figure 4.9 Risk integration according to Method 7 (thresholds of risk approach).
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4.6

Evaluation and recommendations
A short summary of the advantages and disadvantages of the seven methodologies
described in Sections 4.4 and 4.5 is given in Table 4.7. Based on the results of the analysis,
Method 1 is deemed inappropriate for application in the screening of the Danish coast due to
their inability to identify both high-frequency, low-impact risk areas, and low-frequency, highimpact risk areas. Similar problems are encountered using Method 4, where weighting
according to the return period increases this drawback. Methods 2, 3 and 6 suffer the
drawback that variations in integrated risk level are difficult to identify and disseminate.
Method 3 however could be considered as a conservative check for other methods to ensure
that all potential areas of risk are found.
Methods 5 and 7 appear to best suit the needs of DCA to develop integrated risk indices for
the Danish coast. In the analysis of the schematic coastal strip in Section 4.2, these two
methods gave similar results, but varied in magnitude of predicted risk due to the threshold
definitions applied. It is highly recommended to experiment with these two methods using a
case-study site along the Danish coast, and study the effect of changes in the threshold
definitions to find values that appropriately describe risk in the Danish setting. A final check
can be carried out using Method 3 to define if all potential hotspot locations have been
identified by the scan using Method 5 or 7.
Table 4.7

Summary of properties of methodologies

Method
1: Simple summation

Advantages
Simple,
no
assumptions
relating to return period.

2: Marking hotspots

Conservative approach: no
hotspots missed.
Conservative approach: no
hotspots missed.
“Intuitively” correct manner to
deal with return periods.

3: Maximum risk
4: Weighted summation

5: Marking hotspots and
return periods

Conservative approach: no
hotspots missed. Includes
information
about
return
periods.
Allows
flexible
approach in which hotspots
are represented in terms of
return periods, rather than
qualitative integrated risk,
and the implicit valuation of
return periods of impact is
done by the end user of the
screening data.
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Disadvantages
Bias towards frequently-flooded
areas.
High-impact,
lowfrequency
risk
areas
not
identified. No differentiation
based on return period.
No differentiation based on
return period and impact levels.
No differentiation based on
return period.
Great bias towards frequentlyflooded areas and missing highrisk
impact,
low-frequency
areas.
Very
sensitive
to
(arbitrary) choice of weight
factors, those are difficult to
quantify and lack scientific
backing.
Assumes that only “hotspots”
should be included in analysis,
areas with nuisance flooding
(e.g., regular, but low impact)
are ignored.
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6: Hotspot thresholds
defined by return period
7: Thresholds of risk
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Conservative approach: no
hotspots missed.
Analysis closest to true risk
integration by equivalence of
impact and probability.

No differentiation in risk level
shown in final analysis.
Equivalence thresholds difficult
to define a priori.
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5 Development of the Risk Screening Toolbox in ArcGIS
For the application of the risk screening methodology as described in Chapter 3 and
Chapter 4, a Risk Screening Toolbox is developed in ArcGIS. This section focuses on the
development of the toolbox, describes the key considerations for the spatial implementation
of both hazard and exposure datasets and gives recommendations on how to apply the
toolbox in the risk screening process.
As a pilot area for testing purposes, Aarhus bay is selected as it covers a great variety of
typical characteristics of the Danish coastline. The pilot area is used to test different
approaches, to illustrate the effect of different modeller’s choices and to underline our
recommendations on the methodology to be applied.
5.1

General Considerations
In the beginning of this project, DCA presented their idea on the zoning approach, where the
coastal flood hazard of a given return period (band) is represented by its outline (flood
footprint). The main reasons for this simplification were a concern on computational effort
during the screening process and to screen larger coherent areas for the different return
periods.
Contrary to this approach, Deltares proposed a gridded screening of coastal flood hazard and
exposure at risk, as this allows for a much better consideration of local variations of both,
hazard and exposure. In addition, tests have shown that the polygon based approach with 3
zones is not necessarily faster than a geo-processing workflow which is based on raster data
(geotiffs).
As discussed during the DCA-Deltares workshop, the overall risk screening approach will be
based on raster datasets. The main considerations of this decision are the run-time of the
Risk Screening Toolbox, to account for existing uncertainties in both hazard and exposure
data and to enable the combination (integration) of several exposure classes and return
periods into integrated risk levels.
The structure of the Risk Screening Toolbox generally follows a spatial modelling workflow
and covers the following steps:
1. Pre-processing Tools: Preparation of input data (point, line or polygon format),
resampling into raster datasets.
2. Hazard and Exposure Index Tools: Calculation of hazard index (per return period) and
exposure index (per exposure class).
3. Risk Index: Combination of all exposure classes (overall exposure indicator) and
calculation of risk index (per return period).
4. Integration: Combination of all risk indices into an integrated risk index.
In order to ensure a consistent extent and orientation of all raster datasets during the
screening process, a reference raster is derived from the Danish reference grid, which is
applied for snap raster and extent within all geo-processing tools.
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Datasets, toolbox and geo-processing tools are applied in the projected coordinate system
“ETRS 1989 UTM Zone 32N”, projected in Transverse Mercator system with the linear unit as
meters (WKID 25832). Datasets with other coordinate systems are converted into the UTM
systems accordingly.
5.2

Pre-processing Tools
The following section describes the development of the pre-processing tools. The tools are
grouped as toolset 1_Preprocessing in the toolbox (Figure 5.1).

Figure 5.1: Overview of the Pre-processing toolset within the ArcGIS ArcToolbox window.

5.3

Hazard Resampling
This tool is developed for the resampling of an original (high resolution) flood depth dataset
into a raster from lower resolution. During the workshop, it was decided to use raster files with
a resolution of 100m, as tests have shown good results and a reliable representation of the
water depth. Figure 5.2 shows the results for a 100m raster (left) versus a 500m raster (right).

Figure 5.2 Representation of the hazard dataset in a 100m raster (left) and 500m raster (right). The results are
based on the customized routine as described below.

Furthermore it was decided to use the maximum water depth per raster cell as the significant
value, in order to get a ‘conservative’ estimate of the hazard index.
When applying the RESAMPLE tool on the original hazard dataset, cells are only present in
the resampled raster if they are covered to more than 50% with water. This leads to the fact
that the flood depth is not well-represented in the resampled raster for some areas, which
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could be a shortcoming in the analysis (see Figure 5.3, left). Therefore it was decided to apply
a ‘customized’ resampling routine which covers an intermediate conversion step from raster
to point to solve this issue (see Figure 5.3, right).

Figure 5.3 Representation of the hazard using the RESAMPLE tool (left) and the customized routine (right)

However, the customized resampling tool has a significantly longer runtime. We measured
14 minutes per flood scenario for a test case in Aarhus, versus 3 minutes of the standard
resampling routine. Therefore, we added an ‘Aggregation’ step (Maximum condition with cell
factor 6, leading to cells of roughly 10 meters), which leads to a reduction in run-time from 14
minutes to 35 seconds for the same scenario.
The impact of the aggregation step on the flood extent and the representation of water depths
(Figure 5.4) were then tested. In terms of flood extent there is no difference between both
approaches. However, small differences can be observed in the flood depths in cells along
the border of the flood extent. Figure 5.5 shows the frequency distribution and cell statistics of
a raster dataset where both approaches are subtracted from each other. It can be seen that
the differences for few cells along the boundary can be up to 2 meters. In fact, 48 out of 7764
cells show a difference of more than 1 meter; this is less than 1%, while 5% of all cells in this
case have a difference of more than 0.5 meters.
The majority of the cells however do show no or little differences (up to 1cm). Therefore,
these differences were evaluated as not significant and the faster approach is recommended
for pre-processing the hazard datasets.

Figure 5.4 Comparison of flood extent with (left) and without (right) aggregation
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Figure 5.5 Frequency distribution and cell statistics of both approaches

Figure 5.6 shows the complete geo-processing workflow of the customized resampling
workflow with input data (blue box), geo-processing tools (yellow boxes) and (intermediate)
result datasets (green boxes). The tool can be started through a dialogue box, which will be
shown for other tools as an example later in this section. It is important to highlight that the
rasterization in the last step follows the national reference grid to ensure a consistent
orientation and extent of all grids.

Figure 5.6 Overview of the hazard resampling tool in Model Builder.

5.4

Exposure Resampling
The exposure resampling follows the same general considerations as the hazard resampling.
As exposure data can vary for different types, i.e. either point, line or polygon data, different
approaches have to be applied. In the following, the geo-processing workflow for each
exposure class is described.

5.4.1

Economic Activities
The dataset for economic activities, expressed as workplaces, is based on a point dataset,
which contains the number of workplaces per address point. The resampling routine is
therefore based on a point-to-raster approach, which transfers the value from the field
‘workplaces’ into the raster. For further information it is referred to Appendix D.
In a next step, a reclass-table is used to translate the number of workplaces per grid cell into
an exposure score 1-5 (Figure 5.7).
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Figure 5.7 Number of workplaces per grid cell for the area of Copenhagen

5.4.2

Land use
Land use data is typically from polygon type. The conversion is therefore directly based on a
polygon-to-raster tool, where the CORINE land use code is transferred into the raster dataset
(Figure 5.8). In case the resampling needs to be redone, please note that the CLC code in the
original dataset is given as a text field, which needs to be transferred into a number format
first. As the resampling is performed on a national basis, however, the tool only needs to be
applied if changes occur in the raw data.

Figure 5.8 CORINE polygon data (left) and raster dataset (right)

5.4.3

Cultural Heritage
The dataset for cultural heritage is based on point data, which describe the location of cultural
assets. The resampling routine is therefore based on a point-to-raster approach, which
transfers the value from the field ‘Score’ into the raster.
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As for the project no final dataset for cultural heritage was available, the tool was developed
based on example data. The dataset needs to contain a field ‘Score’ in the attribute table,
where the score describes the cultural significance as e.g. proposed in Appendix B.
5.4.4

Transport Infrastructure
This exposure class is typically represented as line features and therefore requires a line-toraster conversion. In a first step, both road infrastructure and railway network have been
combined into a single shapefile (Figure 5.9), where the type of infrastructure is described in
the field class as follows:
-

Class 1: Highways (Danish name: motorvej)
Class 2: Main roads (Danish name: vej over 6 meter)
Class 3: Access roads (Danish name: motortraficvej)
Class 4: Railways (Danish name: jernbane)

Figure 5.9 Example of the transport network line dataset for Aarhus.

The class attribute is transferred into the raster dataset for assigning the exposure index.
5.4.5

Hazardous Facilities
As for the cultural heritage, hazardous facilities are represented as point features, which
specify the location of companies with harmful substances. The dataset contains a field
‘Score’ which is ranging from 0 to 100 and converted into the raster file.
However, it has been found that a direct conversion into a 100m raster does not allow for a
good representation of the location of harmful substance. This is mainly the case because the
locations are registered at a specific address, which can be the post box at the main entrance
of an industrial complex. For example, in Aarhus harbour there are a number of locations with
harmful substances. In the base map and aerial imagery it can be seen however, that the
storage is much larger than just the location of the point (Figure 5.9)
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Figure 5.10 Location of hazardous facilities in the harbour of Aarhus. Note that the storage is much larger than the
representation of the point features.

In order to account for these spatial uncertainties it is proposed to add an additional geoprocessing step where the point feature first is converted into a 500m raster, which is
subsequently resampled to 100m for the exposure index. In this way, the size of the industrial
area is better represented in the 100m raster dataset. Figure 5.11 shows the result for the
harbour of Aarhus.

Figure 5.11 A 100m raster of the exposure class ‘hazardous facilities’ derived from a 500m grid

Note that the point features are not always located in the centre of a 500m raster cell, as the
raster dataset is a continuous grid. To overcome this, it would be possible to use a ‘Buffer’
around the point locations of 250m in order to describe the spatial uncertainty. The buffer
dataset can be converted into a raster dataset afterwards (Figure 5.12). This approach is
however not implemented as a pre-processing routine in the toolbox.

EU Floods Directive in Denmark - Risk index-based method application

31 of 45

11200403-002-ZKS-0006, 18 September 2017, final

Figure 5.12 Alternative approach for hazardous installations using a buffer of 250m and convert the buffer into a
raster dataset

5.4.6

Emergency Response
For emergency response we follow the same approach as for hazardous installations. By
representing the locations of hospitals, police stations and schools, among others, on a 500m
resolution we ensure that these locations are identified in the screening process, even if the
point just falls outside the flood extent. For example it could be that the hospital is not directly
flooded, but still affected due to roads blocked by the flood.
The combined emergency response dataset requires a field ‘Class’ in the attribute table,
where the following classification applies:
- Class 1: police
- Class 2: hospital
- Class 3: fire fighters
As for the hazardous installations, the geo-processing workflow could be altered in case the
representation of the point features in the 500m grid is evaluated to be unsatisfactory.

5.4.7

Ecosystems
Ecosystems are typically represented as polygon features. As there was no real dataset for
ecosystems provided, the geo-processing workflow was developed using a test dataset.
The final dataset needs a field ‘Score’ in the attribute table, with a score ranging from 1 to 5
according to the classification as proposed in Appendix B.
The polygon-to-raster conversion then converts the score into the 100m raster dataset. Figure
5.13 shows an example dataset for Aarhus.
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Figure 5.13 Example dataset for ecosystems with polygons (left) and raster dataset (right)

5.4.8

Utilities
Utilities which provide essential services such as electricity, water or telecommunication can
be represented as point features.
Though most of the infrastructures are also line elements, such as high-voltage transmission
lines or water pipelines, those are usually not susceptible to flooding. If it is required also to
take the line infrastructure into account, a line-to-polygon conversion can be added to the
geo-processing workflow.
As before for hazardous facilities, the utility dataset need to contain a field ‘Score’ in the
attribute table which ranges from 1-5 according to the classification proposed in Appendix B.
This attribute is converted into the 100m raster dataset accordingly.

5.5

Hazard and Exposure Indices
In the next step, the raster based information on hazard and exposure is translated into a
hazard index or exposure index, respectively.
As the workflow is comparable for most of the datasets it is explained for the hazard and a
selected exposure class.
All tools are grouped under Toolset 2_CalculateIndex in the Risk Screening Toolbox (Figure
5.14).

Figure 5.14 Overview of the Toolset 2_CalculateIndex for calculating the hazard and exposure index.

EU Floods Directive in Denmark - Risk index-based method application

33 of 45

11200403-002-ZKS-0006, 18 September 2017, final

The tools are based on so-called reclassification tables, which specify a range of values for
which a given index is assigned. Table 5.1 shows an example of a reclassification table for
the flood hazard, where the range of water depth in the resampled hazard dataset for each
index class is specified. This table follows the classification as proposed in Appendix B.
Table 5.1

Example of reclassification table for the flood hazard

Value from
0.01
0.25
0.7
1
1.5

Value to
0.25
0.7
1
1.5
99

Index
1
2
3
4
5

This classification is stored as a csv-file in folder ’07_conversion tables’ in the directory of the
Risk Screening Toolbox. If the classification as proposed in Appendix B needs to be modified,
this can be done in the csv-file directly. Afterwards, the hazard index tool can be executed
again, which will use the modified classification for assigning the index. Figure 5.15 shows the
csv-file which can be modified if a different classification is required without changing the geoprocessing tools or any other source code.

Figure 5.15 csv-file of the test reclass table, which can be modified easily if a different classification is required.

Figure 5.16 show the hazard reclassification based on the 1/1000 flood scenario for Aarhus. It
can be seen that the areas with water depths > 1.5 meters get an index of 5 (red), while lower
water depths have an index of 4 and less. To grid cells outside the flood footprint no index is
assigned.

Figure 5.16 Hazard reclassification from water depth (left) into the hazard index (right) based on the 1/1000 flood
scenario
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As all other geo-processing tools, the hazard index too is executed through a dialogue box
where (1) input dataset, (2) reclassification table and (3) hazard index dataset can be
specified (Figure 5.17).

Figure 5.17 Dialogue box for the hazard index geo-processing tool in ArcGIS.

For the exposure index, the workflow is comparable to the process for the hazard index. For a
number of datasets a score was directly specified in the attribute table:
-

Cultural heritage,
Ecosystems,
Utilities.

For these classes the geo-processing is limited to a reclassification of the raster cells with a
value of 0, as the lowest value for the exposure index has to be 1, according to the CRAF
methodology and to avoid a risk index value of 0. Therefore in the raster calculator the
expression “Con(IsNull("raster.tif"),1,"raster.tif") is applied, which changes all NULL fields into
the value 1.
For the remaining exposure classes, the reclassification is based on reclassification tables as
described above. Table 5.2 show the reclassification values for the CORINE land use
classes.
Table 5.2

Example of a reclassification table for the land use index

From Value
111
112
121
122
131
141
211
221

To Value
111
112
121
124
133
142
213
223

Index
4
3
4
1
3
2
2
2

From Value
231
241
311
321
331
411
421
431
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To Value
231
244
313
324
335
412
423
999

Index
2
2
2
2
1
2
1
1
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Figure 5.18 shows the reclassification from the land use class into the land use index based
on the classification in Table 5.2.

Figure 5.18 Reclassification of CORINE land use class (left) into land use index (right)

The same procedure is applied for the remaining exposure classes where a ‘Class’ is
specified in the attribute table to be converted into an index.
5.6

Integration of Exposure Classes
The next step is the integration of all exposure classes following the approach as proposed in
the beginning of Section 3.4. Hence, the overall exposure indicator is calculated per raster
cell as the maximum index of all exposure classes, with each indicator valued and ranked
from 1 to 5.
In order to identify the highest index per raster cell, we use the Maximum condition in the Cell
Statistics tool. Figure 5.19 shows the dialogue box for the integration tool, which is part of the
Toolset 3_CalculateRiskIndex.
Figure 5.20 shows an example for the overall exposure index for Aarhus. It can be seen that
the highest index is given to areas with high population density in the city centre, the
highways, and a fictitious ecosystem from highest importance as well as a hazard facility in
the city centre. Note that these results are for illustration purposes only.
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Figure 5.19 Dialogue box for the integration of all exposure classes based on the individual indices.

Figure 5.20 Example of the Overall Exposure Index for Aarhus.

EU Floods Directive in Denmark - Risk index-based method application

37 of 45

11200403-002-ZKS-0006, 18 September 2017, final

5.7

Risk Index
Next, the risk index is calculated per return period as described in Section 3.5 as the Square
root of the product of hazard index and overall exposure index.
The process is facilitated by a geo-processing routine which includes all three return periods
in the same tool and results in three Risk Index datasets (Figure 5.21).

Figure 5.21 Dialogue box for the calculation of the risk index per return period

5.8

Integration of Return Periods
The last toolset in the Risk Screening Toolbox enables the combination of all return periods
into one integrated risk index.
In Chapter 4 several methods are proposed. To test the three approaches which were
selected as most promising during the workshop, three tools were built within the toolbox
‘4_IntegrateReturnPeriods’ for Method 5, Method 7 and Method 3.
The outcome is an Integrated Risk Index dataset which forms the end-result of the Risk
Screening Toolbox.

5.8.1

Method 5: Marking hotspots and return periods
In Method 5, the highest risk index per return period is taken as follows:
-

very high (1/1000) = 1 – medium risk
very high (1/100) = 2 – High risk
very high (1/20) = 3 – Very high risk

The geo-processing routine consists of a conditional Raster Calculator expression and the
Cell Statistics Tool, which combines all three risk index datasets into an integrated risk
dataset.
The results of the integration for Method 5 are shown in Figure 5.22.
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Figure 5.22 Result for the Integrated Risk using Method 5

5.8.2

Method 7: Thresholds of risk approach
In Method 7 the risk index above a given threshold is taken from each return period as
specified below:
-

-

very high risk
o risk index (1/20) > 4.4
high risk
o risk index (1/20) > 3.8
o risk index (1/100) > 4.4
medium risk
o risk index (1/20) > 3.1
o risk index (1/100) > 3.8
o risk index (1/1000) > 4.4

As before, the calculation of the integrated risk index is performed using a combination of
Raster Calculator and Cell Statistics.
Figure 5.23 shows the model builder workflow of the integration tool. Note that there is a
Raster Calculator (4) which leads to the dataset ‘m7_0_other’. This addition was made to
outline areas which do not fulfil the abovementioned conditions, but are flooded in one of the
return periods. These cells receive the value 0 and can be shown in a different colour to
underline that they are still flood prone.
Figure 5.24 shows the result for Method 7.
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Figure 5.23 Geo-processing workflow for Method 7 in model builder

Figure 5.24 Result for the Integrated Risk using Method 7

5.8.3

Method 3: Maximum risk indicators
In Method 3 only the results of the 1/1000 year risk index is taken as follows:
-

very high: risk index (1/1000) > 4.4
high: risk index (1/1000) > 3.8
moderate: risk index (1/1000) > 3.1

As before, this classification is performed using the Raster Calculator and Cell Statistics,
resulting in one dataset with the integrated risk index ranging from 0 (no significant risk) to 3
(very high risk). The result of the integration is shown in Figure 5.25.
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Figure 5.25 Result for the Integrated Risk using Method 3
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6 Conclusions
The Danish Coastal Authority (DCA) is preparing for the second cycle of the implementation
of the EU Floods Directive. While implementing the EU Floods Directive in Denmark, the DCA
is required to appoint areas where coastal and fluvial flood risk level is significant, to provide
more detailed mapping at these specific areas, and to guide towards the identification of risk
management measures.
As a first step, areas with high-risk of coastal and fluvial flooding will be identified. In the
second cycle, DCA aims at adapting the screening assessment, developed for the first cycle,
towards a more risk based approach. This requires changes in the screening process to
include new knowledge on the physical definition of the size of risk areas, climate scenarios,
and the inclusion of both tangible and in-tangible exposure classes.
To ensure a better basis for the selection of management areas, a risk index-based method
has been developed delineating the risk level on the basis of the available hazard and
exposure datasets. To that end, vulnerability types (i.e. receptors) to be included in the risk
assessment have been defined. In addition, the quantification of the vulnerability in an
exposure indicator has been proposed on the basis of the available datasets. Moreover, risk
integration methodologies for multiple return periods have been proposed for the purpose of
defining the high risk management areas. Finally, the defined methodology is supported by a
Risk Screening Toolbox developed in ArcGIS enabling risk level computation along the
Danish coast.
The Coastal Risk Assessment Framework (CRAF), developed in the FP7 EU project RISCKIT, has been used for a comprehensive and systematic approach to identify and select
hotspots (to be further analysed), through the calculation of a risk index. The approach
calculates Hazard and Exposure Indices following an existing and established methodology
(the index-based method).
The exposure indicators measure the relative exposure for different receptor types. Following
the CRAF methodology, tailored for the Danish case, the main exposure types that have been
considered are Land Use, Population density, Ecosystems, Cultural heritage, Transport
systems, Utilities, Emergency services, and Economic activities. An overall exposure indicator
is calculated as the maximum index of all exposure classes, with each indicator valued and
ranked from 1 to 5.
The Risk Index is then calculated using the square root of the geometric mean of the hazard
indicator (ih) and the overall exposure indicator (iexp).
Although the CRAF methodology allows the identification of hotspot areas for multiple
individual return periods (probability of occurrence) of coastal hazards, the methodology was
not envisaged to compute an index of risk that is integrated across multiple return periods
(i.e., accounting for variations in impact for varying return period values). As part of this
project, a methodology for the combination of the risk index for several return periods was
therefore developed.
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Seven methodologies were considered. Two of them appeared to best suit the needs of DCA
to develop integrated risk indices for the Danish coast. First, the so-called “Marking hotspots
and return periods” method is based on the identification of hotspots of risk, defined as cells
with high or very high risk indices. The assessment is carried out for all return periods, and
the minimum return period for which a cell becomes a hotspot is recorded. Second, the socalled “Thresholds of risk approach” method seeks to implicitly account for equivalence
between more frequent, but lower impact flood events, and less frequent, higher impact flood
events.
Finally, for the application of the risk screening methodology, a Risk Screening Toolbox has
been developed in ArcGIS. As a pilot area for testing purposes, Aarhus bay has been
selected. The Risk Screening Toolbox has been applied to the pilot area to test different
approaches, to illustrate the effect of different modeller’s choices and to underline
recommendations on the methodology to be applied.
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A

Folder structure of the GIS database

* templates
* DK land sea bounday
* 100m reference grid (used for snap raster)
* 500m reference grid (for selected exposure classes)
* GIS data (polygon)
* includes raw-data for conversion
* including hazard and exposure
* 01_hazard
* 02_population
* 03_landuse
* 04_cultural_heritage
* 05_transport
* 06_hazardous_facilities
* 07_emergency_management
* 08_ecosystems
* 09_utilities
* 10_economic_activities
* GIS data (raster)
* folder structure as above
* contains the rasterized national datasets
* including hazard and exposure
* hazard index
* exposure index
* risk index
* conversion tables (csv-files for geo-processing tools)
* layer files (symbology templates for geo-processing tools)
* model builder tools (toolbox itself)
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B

Overview of Ranking of Indicators

EU Floods Directive in Denmark - Risk index-based method application

B-1

11200403-002-ZKS-0006, 18 September 2017, final

C

Recommendations for the Risk Screening Toolbox
It is recommended to remove all open water bodies and the remaining water along the
shoreline from the risk map. Concerning open water bodies, for example in Figure C.1 high
scores are shown for two areas, from which one is actually a lake In order to avoid a
misinterpretation of the hazard score and to improve the selection of areas at significant flood
risk, it is recommended to remove lakes and other permanent water bodies, beaches (cf.
Figure C.2) and even the river bed from the high resolution hazard dataset, before the hazard
screening is carried out.

Figure C.1 Example of the hazard index for a lake (left part of the figure) and a low-lying residential area (right part
of the figure)

Figure C.2 Comparison of hazard index for method 7 with beaches (left) and without beaches (right)

All tools are prepared for running the Risk Screening Toolbox on a national level. Several
exposure classes are already included as national datasets, while a few only contain clipped
datasets for testing purposes.
For the hazard however, the files are currently prepared per coastal stretch. It is
recommended to combine all raster files with the same return period and combine them into
one complete raster file using the ‘Mosaic as new raster’ tool in ArcGIS. In this way, the
analysis can be carried out on a national basis very efficiently and with very short calculation
time. In case that there are revisions for one or more water depths files, these files can be
updated in the folder with hazard data from the same return period and the new raster can be
built again.
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D Description of the workplace geo-referencing approach
D.1

Introduction
For the assessment of potential adverse effects for companies due to flooding, the number of
workplaces is used as a parameter in the risk screening phase. However, the data from the
statistical office are not geo-referenced and therefore, cannot be used in the risk screening.
This appendix describes an approach to geo-reference the number of workplaces, as
registered in the LIFA database, for the assessment of potential flood losses in the frame of
the second cycle of the Floods Directive 1.
In Section D.2 the available data is described briefly. The chosen approach is described
step-by-step in Section D.3. Additional advice is given how to overcome problems with data
for selected steps. In Section D.6, possible limitations of this approach are described.

D.2
D.2.1

Available data
Database ‘addresses’
The first database is the address database as provided by DCA in a Microsoft Access
database file. The database contains one entry per house number, in total more than 2.5
million registered addresses. For each house number, a coordinate is given (Northing,
Easting) in the ETRS geographic reference system.
In addition to the house number, the municipality name, municipality code, zip-code and
street-code, among other data, is given. Figure D.1 shows a screenshot of a part of the
database.

Figure D.1 Screenshot of a part of the address database. Note the first three columns with codes.

The address code (in the database: aadrkode) is a combination of the municipality
(Kommune), street (vej_kode) and house number (husnr). The 11 digits have the format
KKKVVVVHHH with either a low dash (_) or a letter at the end, if the house number contains
an A, B, C, respectively.

1

Disclaimer: This memo is not a scientific report but rather a step-by-step guidance to replicate the geocoding for
additional GIS data as requested by DCA. For this reason, mainly technical terms and screenshots are used to
describe the workflow.
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D.2.2

Database ‘companies’
The second database contains information about the workplaces per registered company. It is
distinguished between two different types companies (jur = juristic and prod = productive)
provided as two tables in a Microsoft Access file.
Each company is registered at an address, which is listed with the same code for the
municipality, street and house number as in the address database. However, there is not yet
a 10 digit address code per database entry. Figure D.2 shows a screenshot of the company
database with the name of the company and related address information.

Figure D.2 Screenshot from the company database with name of the company and address information (last two
columns in the picture).

D.3
D.3.1

Approach
Preparing the address dataset
To be able to geo-reference the data, the address database is exported as a dbf-file (dBase
file) from MS Access and then imported into ArcGIS using the ‘Add XY data’ dialogue 2. The
geographic reference system is set as ‘ETRS 1989 UTM Zone 32N’ (WKID 25832).
Within ArcGIS the address code is reduced to 10 digits by removing the last digit (as this
information is less relevant for the geocoding) using the Python expression
calc(!AADRKODE!)
def calc(adrcode)
return adrcode[:10]
Now, the 10 digits only contain numbers, which is important for later processing steps. Figure
D.3 shows a screenshot of the data in ArcGIS. Each address point is labelled with the 10 digit
address code.

2

As this dataset is already created, this preparation steps does not need to be carried out again.
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Figure D.3 Example for the address code per address point in the inner city of Copenhagen.

D.3.2

Preparing the company dataset
As the following operations require substantial computational resources in Excel, it is advised
that the dataset is split into smaller sections, e.g. by municipality number.
First, a filtered view is created from the table view (e.g. dbo_CVR_JUR_ENH) by selecting
the kommune_kode column. Then, a filter by municipality numbers can be done by using the
‘Selection’ > ‘Between’ option in the Sort&Filter section of the ‘home’ tab (Figure D.4). In this
example we selected all municipalities between 001 and 250.

Figure D.4 Select ‘between’ dialogue box for selecting entries by municipality numbers

Next, all filtered database entries are selected, using the ‘Select’ > ‘Select All’ option in the
‘Find’ menu (Figure D.5).
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Figure D.5 Select all option before exporting the database entries.

The selection is then exported as an Excel file, using the ‘Export’ > ‘Excel’ button in the
‘External Data’ tab (Figure D.6).

Figure D.6 Exporting the database into an Excel spread sheet

Note that in the Export dialogue two checkboxes need to be activated, as otherwise all entries
of the database are exported into Excel (Figure D.7). The file name of the spread sheet
should indicate the range of municipalities as filtered above (in this case
JUR_companies_kommune-001-250.xls).
In Excel, new columns are created for municipality (CCC), way (VVVV) and house number
(HHH). The columns are filled with the data from the original columns with the respective
code. However, in order to get the leading zero(s), the format needs to be a text field, using
the following command:
=TEXT(F2;"0000")
which would result in 0011 for the way (number) 11 in field F2. For CCC and HHH, three
digits are required, while VVVV requires 4 digits.
A new column CODE_TXT is made for the 10 digit code, which combines the above
generated fields using the command:
=CONCATENATE(AE2;AF2;AG2)
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Figure D.7 Dialogue box for exporting the data into Excel

It is advised to convert the text field into (integer) values to ensure that the field can be read in
a later stage of the process. The following approach is used to convert the numbers:
(i) create a new column
(ii) copy the entire CODE_TXT column (right click > copy)
(iii) right click on an empty column, select ‘paste special’ > ‘paste special’
(iv) in the dialogue box, under the ‘paste’ section, select ‘values’, and under the operation
section, select ‘add’ (see Figure D.8). Confirm the dialogue by clicking OK. The
values are now pasted as (integer) values in the new column.
(v) rename the column into ADDRESSCODE

Figure D.8 Steps to past the text fields as (integer) values

For now, this is the last step of preparation the company database. The spread sheet will be
used in a later step again.
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D.4

Combining both datasets
The combination of both datasets is based on a VLOOKUP function in Excel as described
below 3.
First, from the GIS address shapefile, a selection of municipalities is made which matches the
selection as in the company Excel spread sheet above. For example, in the ‘Select by
Attribute dialogue box, the following expression is used:
"KOMMUNE_NR" > 000 AND "KOMMUNE_NR" <=250
Then, the selection is exported as a new shapefile (right click on the shape file in the Table of
Content > ‘Data’ > ‘Export Data’. The new shapefile is saved, with the file name indicating the
selection of municipality numbers.
In Excel, the dbf-file assigned to the shapefile as saved above is opened 4, which now
contains the XY and address code for the selected municipalities. All other columns can be
deleted and the document is saved as a new .xlsx spread sheet.
Then, all three columns are selected and pasted into the second worksheet of the company
xlsx-file as generated under Section 3.2 and rename the worksheet as list_XY. Now, this
spread sheet contains company information including the address code as well as XY
information with the address code on the second sheet.
The combination of both information is made using the VLOOKUP function. The following
steps are performed in the company spreadsheet:
 move the address code to the first column of the spread sheet
 create a new column X
 create a new column Y
 check the number of lines in the list_XY worksheet. In this case say it is 150,000
 in the company worksheets, enter the following expression in the first field of the X
column (see Figure D.9): =VLOOKUP(A2;list_XY$A$2:$C$150000;2;FALSE)
 copy and paste the expression in the Y column, and change the ;2; into a ;3;. The
function now looks up the value as found in A2, this is the address code, and gives
back the value found in the second column, which is the X value, as well as the value
found in the third column, which is the Y value.

Figure D.9 VLOOKUP function for the X coordinate
3

4

An alternative approach using the JOIN function in ArcGIS to join the list of XY coordinates with the company
information based on the 10 digit address code was not working properly, as only the first match per XY is joined.
However, multiple companies can be registered at one address. In addition, there were significant stability issues
with ArcGIS, even if using only smaller parts of the address shapefile.
I usually use drag&drop of the dbf-file into an empty Excel spread sheet.
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Now, double click on the small black marker on the lower right side of the box to auto
fill the function for all entries below (Figure D.10). Excel now might need some time to
look up the values, which is indicated by a small remark ‘computing’ on the right side
of the status bar in Excel.

Figure D.10 Company information with XY information



As a last step, all entries are selected and pasted as ‘values’ into a new spread sheet.
This removes all functions included in the spread sheet which may cause
compatibility issues in ArcGIS in the following step.

In the next step, the company information including XY coordinates is imported into ArcGIS
using the File > Add Data > Add XY Data dialogue 5. The coordinate system is set to ‘ETRS
1989 UTM Zone 32N’ (WKID 25832).
The imported dataset is exported as a new shapefile (right click on the shape file in the Table
of Content > ‘Data’ > ‘Export Data’) and added to the Table of Content when asked. At a later
stage, all datasets can be combined using the Merge function in the Data Management
toolbox.
Figure D.11 shows the imported company information in ArcGIS.

5

it seems as if X and Y are switched in the Excel. When adding the XY data in ArcGIS I had to switch the values to
obtain a correct result.

EU Floods Directive in Denmark - Risk index-based method application

D-7

11200403-002-ZKS-0006, 18 September 2017, final

Figure D.11 Imported company information in ArcGIS, indicated by the green points. Note that multiple points can
have the same XY coordinate.

D.5

Postprocessing
As the number of workplaces is given as a range (e.g. 1-5) in a text field, a conversion into
Integer (mean) value is required in the post processing step. First a new field ‘workplaces’ is
created (Figure D.12).

Figure D.12 Create new field ‘workplaces’

Next, the text field is transferred into an integer value using the following Python if-then-else
statement:
def calc (text):
if text == '0':
return 0
elif text == '1':
return 1
elif text == '2 - 4':
return 3
elif text == '5 - 9':
return 7
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elif text == '10 - 19':
return 15
elif text == '20 - 49':
return 35
elif text == '50 - 99':
return 75
elif text == '100 - 199':
return 150
elif text == '200 - 499':
return 350
elif text == '500 - 999':
return 750
elif text == '1000+':
return 1000
else:
return 0
In the example shown in Figure D.13 the number of workplaces for the reference year is
chosen. However, also other values such as seasonal number of workplaces can be used as
an indicator, if applicable.

Figure D.13 Calculate field dialogue to transfer the text value into an integer field

Note that multiple points can have the same XY coordinate. When converting the point
shapefile into a raster grid, the SUM function is used to take all workplaces per grid cell into
account.
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D.6

Limitations
The chosen approach has mainly two limitations.
At first, the dataset needs to be split into smaller selections as the number of entries in the
database exceeds the number of lines and .xlsx-file can handle.
Secondly, there are a number of incomplete entries in the database, for which no XY
coordinates can be found. For example, if the address database does not state a house
number, the 10 digit address code ends with 000, which is however not listed in the XY
database.
The analysis has shown that there are 37,242 entries without a correct address code. Out of
2,501,149 address points, this is a rate of about 1.5%. However, from this number, 36,962
lines have no XY information at all, making them completely unusable. The remaining 280
addresses with an incomplete code only represent 0.01% of all addresses, which means the
geocoding was successful for 99.98% of all data points. This rate is evaluated to be
satisfyingly complete.
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